
CD / Spectrum Pro

CD / Spectrum Pro Version is a CD-Audio player with built-in graphical spectrum analyzer. It was designed to run 
on Windows 95 and Windows NT 4.0. Version 3.0 was designed to run in conjunction with The Psychedelic Screen 
Saver v3.5 to provide stunning visuals that are synchronized to the beat of the music you play on the CD. This 
document describes how CD/Spectrum Pro operates. 
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CD/Spectrum Pro Hardware Requirements

Although CD/Spectrum Pro will run on a 486, a Pentium is recommended for optimum performance. If your 
machine has trouble keeping up with the processor-intensive spectrum analysis, you may choose to use only the 
CDaudio part of the program.

Of course a CD player is required for the CDaudio portion of the program to function. If your system has more than 
one CD drive, you can choose which one CD/Spectrum Pro will use by right-clicking either on the “CD” indicator 
in the Console window, or anywhere in the CD player window. Currently, CD/Spectrum Pro provides no special 
support for multidisc changers, so although it should work with them, it will not be able to provide changer-specific 
functionality like changing which slot is playing.

A sound card in necessary for the spectrum analyzer to function. The spectrum analyzer uses the wave capture on the 
sound card to determine what the CDaudio signal looks like. If no sound card is present, or the sound card does not 

support wave capture, you may choose to use only the CDaudio part of the program.



CD/Spectrum Pro Installation

Installation is simple. A self-installing executable program is provided that performs all of the necessary installation 
chores. This installation program puts an icon on your desktop from which you can run CD/Spectrum Pro. Note that 
if you later choose to uninstall CD/Spectrum Pro, you should do so using the “Add/Remove Programs” applet in 
Control Panel.



CD/Spectrum Pro General Information, Tips, and Tricks

The following tricks and tips may be helpful when using CD/Spectrum Pro.

· You can resize and move each window individually. 

· To move a window one pixel at a time, use the arrow keys.

· To resize a window one pixel at a time, use ‘x’ to make it smaller horizontally, ‘X’ to make it bigger. Use ‘y’ to 
make it smaller vertically, ‘Y’ to make it bigger.

· If you hold the control key down while dragging a window around, the rest of the windows will move as well.

· You can align all the windows on one edge by holding the <Control> key down and hitting one of the arrow 
keys. All CD/Spectrum Pro windows will then align themselves with the respective side of the active window.

· You can stretch all the windows to reach the same point by holding the <Shift> key down and hitting one of the 
arrow keys. All CD/Spectrum Pro windows will then stretch themselves so that they are aligned on the 
respective side of the active window.

· Right-click on things to get context menus. You can get such a menu from almost anywhere in the program.

· Tooltips are provided for most buttons. Let the mouse cursor linger over a button to get a small text description 
of what the button does.

· The program remembers the last position of each of the windows. Further, you can store your favorite layouts in 
the Layouts window.

· The Register buttons turns into an About button and the nag dialogs disappear once the program is registered.

· Hit <Enter> to move between tracks, or <Tab> to move between fields, in the CD entry screen.



CD/Spectrum Pro Configuration

You can configure each element of CD/Spectrum Pro. The engines are configured by right-clicking either on the 
indicator in the Console window, or on the respective window (for example the CD window for the CD engine). The 
individual windows are configured by right-clicking on the respective window. Suffice to say, right-click on 
something to configure it.

· CD Audio

· Is Default CD Player - if this option is chosen, Windows will run CD/Spectrum Pro to autoplay CDs.

· Intro Duration - the number of seconds that will be played from each track in Intro mode.

· Logical CD Drive - the logical drive letter of the CD drive that CD/Spectrum Pro will use.

· Autoplay Programmed - if this option is chosen, CD/Spectrum Pro will engage programmed play when 
autoplayed. Otherwise, normal play will be used.

· Auto Eject after Last Track - If this option is chosen, CD/Spectrum Pro will automatically eject the CD 
after play has completed.

· Stop CD on Exit - If this is chosed, the CD will stop playing when you exit CD/Spectrum Pro.

· Spectrum

· HiColor and LowColor - The spectrum will be displayed with the high color unless the Gradient option 
is chosen, in which case the spectrum is dithered so that the low elements are LowColor and the high 
elements are HiColor.

· Spectrum Trails Duration - adjusts the linger duration of the spectrum trails.

· Global

· 3D Look - if chosen, CD/Spectrum Pro will make its buttons look recessed.

· Layouts - provides a quick interface to choosing from the saved layouts.

· Colors - this option provides a dialog box within which you can set the colors CD/Spectrum Pro uses 
for things like background color, button color, etc.



CD/Spectrum Pro CD-Audio

The CD/Audio player in CD/Spectrum Pro has the following features:

· Up to 100 tracks per CD.

· Programming by track, or by segment (time within a track).

· It reads information from the Windows CDPlayer, so if you have already entered your CD titles and tracks, 
CD/Spectrum Pro will read them so will not have to enter them again. However, CD/Spectrum Pro store the 
information in another location to allow more CDs to be stored. In fact, the number of CDs you can enter is 
almost unlimited.

· It is integrated with The Psychedelic Screen Saver for stunning visuals that are synchronized to the music you 
play.

Several buttons make the CD audio player easy to use. To play a track on the CD, simply click on the track’s number 
in the grid. 

Click the Tracks button to get a list of tracks. Other buttons include:

Repeat button. When it is depressed, play will repeat after the program or CD is finished.

Random button. When it is depressed, tracks will be played in a random order.

Program button. When it is depressed, tracks will be played in the order dictated by the program for the current CD.

Intro button. When it is depressed, only the beginning of each track will be played. This option affects Regular, 
Random, and Programmed play.

Eject button. This button ejects the CD. On computers with CD players that support it, this button will also suck the 
drawer back in. Not all CD players support this.

CD Info button. This button launches a dialog box used to edit the title, artist, tracks and programming on this CD. 
The dialog box and entering of this information are discussed below.

Play button. This button begins playing the CD.

Back button. This button moves back to the previous track. In random or programmed mode, it moves to the 
previous random or programmed track, respectively.

Forward button. This button moves forward to the next track.In random or programmed mode, it moves to the next 
Random or programmed track, respectively.

Pause button. When depressed, play will be paused.

Stop button. Stops play.

Restart button. Restarts play at the beginning of the current track.

A trackbar is also provided to locate the current position within a track. Simply drag the trackbar to the desired 
location and play will resume there.

Editing the Program List

The “CD Info” button will bring up a dialog in which the current CD’s information can be edited. This dialog has 
three pages.

CD Overview Page: This page displays the current CD title, artist(s) and track titles.

CD Information Page: This page is used to enter the title, artist and track title information for the current CD. You 
can also enter an optional comment for the CD, and an optional comment for each track. If CD/Spectrum Pro is not 
recognizing a CD for which you have downloaded a CDP file, you can click on the Override button to locate the CD 
information and use it for the current CD. On this page, <Tab> moves between fields, and <Enter> brings up the 



next track. For the fields which allow multiple lines (comments), <ctrl><enter> will insert a line-break.

Programming Page: This page is used to edit program for the current CD. On this page, you can add/move/remove 
tracks, and music segments to/from the program. A segment starts at a track-minute-second and ends at a later track-
minute-second. If your program does not play, it is probably because the music segment is invalid. Be sure to choose 
a segment that exists and has an ending time which is later than the starting time.



CD/Spectrum Pro Spectrum Analyzer

The Spectrum Analyzer employs a Fast Fourier Transform to derive the frequency spectrum of the sound as it comes 
off the sound card. This spectrum is then displayed in the Spectrum window as a series of graphics. Below the 
frequency spectrum, left and right volume are displayed.

Eight buttons adorn the right side of the Spectrum Analyzer: Left & Right, Center, Split, Combined, Audio, Spectral, 
Trails and Gradient.

· Left & Right - When this button is selected, frequency information for both left and right channels is 
displayed.

· Center - When this button is selected, monaural frequency information is displayed. This button and the 
Split button cannot be depressed at the same time.

· Split - When this button is selected, the left, right and center channel frequency information is physically 
separated in the graph. 

· Combined - Opposite of split.
· Audio - When this button is selected, the spectrum is shifted to compensate for our human ears. It should 

look a lot like it sounds.
· Spectral - When this button is selected, the spectrum is shown in its raw state - each frequency is given 

equal weight and the spectrum is physically accurate.
· Trails - When this button is selected, the spectrum graphics will show trails at the peak values. Trail 

duration is adjusted by right-clicking on the spectrum and choosing to configure the spectrum.
· Gradient - When this button is selected, the spectrum is displayed using a gradient of colors ranging from 

the low color to the high color. These colors can be selected by right-clicking on the spectrum and choosing 
to configure the spectrum.

A Gain trackbar is also provided to help adjust the gain of the signal into the spectrum analyzer. This has no effect 
on volume - to change volume, look to the Console or Mixer windows.

Right-click on the spectrum to get a context menu that will allow you to turn spectrum trails and hi resolution on/off, 
as well as perform other functions.



Design and Philosophy of CD/Spectrum Pro

Version 3.0 of CD/Spectrum Pro represents a departure from the previous versions in its design. Previous versions 
were designed with one main window containing all of the program, and it was found that this was restrictive. So, 
version 3.0 was written (from scratch) to be much more modular - both in code and in use.

CD/Spectrum Pro 3.0 (or later) now has a main window (a console) from which many other windows can be 
launched. Control over the engines are also available from the console, as is a master volume control.

The engines are the parts of the code that control the hardware. For example, the CD engine keeps track of what’s 
happening on the CD drive. There is an engine each for the CD drive, the wave capture, and the mixer. These 
engines can be on without any windows other than the console being up. This separation of engine from user 
interface (UI) mimics a client-server approach in that any number of UIs (clients) can be written to use each engine 
(server). For example, both the CD window, and the CD taskbar icon use the CD engine.

Version 3.0 is also the first multithreaded version of CD/Spectrum Pro. This helps the program remain responsive 
even when one of the components is busy with a time-intensive task.
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Release Notes / License Agreement

The Psychedelic Screen Saver - Version 3.5
Copyright (C) 1995-1997 / Mike Irvine - All Rights Reserved

CD Spectrum Pro - Version 3.0
Copyright (C) 1995-1997 / John Hornick - All Rights Reserved

Release Notes

· Installing The Psychedelic Screen Saver v3.5 will overwrite prior versions of The Psychedelic Screen 
Saver. If you've installed a previous version (2.5 or higher) you may want to backup, rename, or 
otherwise save the file "psych.scr" in your \system directory (on Win95) or \system32 directory (on 
WinNT).    Psych v3.5 is compatible with your existing saved settings.

· The Psychedelic Screen Saver v3.5 is free to users who have registered version 3.0 and is available 
to users who have registered a previous version of The Psychedelic Screen Saver as a $10 upgrade. 
This fee licenses you for Psych 3.x but not for CD    Spectrum Pro. CD Spectrum Pro is a separate 
product made by another ShareWare developer and must be registered separately.

· Registering Psych v3.5 gives you a license to use all updates of The Psychedelic Screen Saver prior 
to version 4.0 and *ALL* previous versions.

· Your system must have a sound card installed (and properly configured) in order for The Psychedelic 
Screen Saver to sync with sound.

· CD Spectrum Pro must be running in order for The Psychedelic Screen Saver to sync with sound.

License Agreement

0 Users of either 'The Psychedelic Screen Saver' or 'CD Spectrum Pro' must accept this disclaimer 
of warranty: both 'The Psychedelic Screen Saver' and 'CD Spectrum Pro' are supplied as is.    The    
authors disclaim all warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose. The authors assume no liability for damages, direct or 
consequential, which may result from the use of either 'The Psychedelic Screen Saver' or 'CD Spectrum 
Pro'."

1 Both 'The Psychedelic Screen Saver' and 'CD Spectrum Pro' are "shareware" programs and are 
provided at no charge to the user for evaluation.    Feel free to share them with your friends, but please do 
not give them away altered or as part of another system.    The essence of "user-supported" software is to 
provide personal computer users with quality software without high prices, and yet to provide incentive for 
programmers to continue to develop new products.    If you find either program useful and find that you 
are using either program after a reasonable trial period, you must make a registration payment to 
NorthStar Solutions for either.    This payment will be:

· $20 if you are just registering 'The Psychedelic Screen Saver'
· $20 if you are just registering 'CD Spectrum Pro'
· $30 if you are registering both products

The registration fee will license one copy of each program for use on any one computer at any one time. 
You must treat this software just like a book.    An example is that this software may be used by any 
number of people and may be freely moved from one computer location to another, so long as there is no 



possibility of it being used at one location while it's being used at another. Just as a book cannot be read 
by two different persons at the same time.

Commercial users of either 'The Psychedelic Screen Saver' or 'CD Spectrum Pro' must register and pay 
for their copies within 30 days of first use or their license is withdrawn. 





Registration

The Psychedelic Screen Saver 3.5
and/or

CD Spectrum Pro 3.0

If you enjoy using The Psychedelic Screen Saver and/or CD Spectrum Pro, you may register them 
through NorthStar Solutions by any of the methods described below.    After NorthStar processes your 
registration, they will send you a registration number that you will need to enter in the registration dialog in 
order to remove the registration reminder messages. 

      Please note that NorthStar Solutions is not the author of this software. They are contracted by the 
authors solely to process registrations.    They do not provide technical support for the software and they 
cannot answer questions about anything but the registration process.    If you need technical support, 
please read the following sections in the online help:

· Support for The Psychedelic Screen Saver
· Support for CD Spectrum Pro

REGISTRATION TYPES

    1) The Psychedelic Screen Saver v3.5 (screen saver only) for $20 US.

    2) CD Spectrum Pro v3.0 (CD Player only) for $20 US.

    3) Both products for $30 US.

    4) Upgrade your pre 3.5 version of The Psychedelic Screen Saver to v3.5 (screen saver only) for $10 
US

SITE LICENSE PRICING OPTIONS

The Psychedelic Screen Saver:

   Licenses       Cost per License
   1              $20
   2 - 9          $17.50
   10 - 49        $10
   50+            contact pixel@halcyon.com for pricing

CD Spectrum Pro:

   Licenses       Cost per License
   1              $20
   2 - 9          $17.50
   10 - 49        $10
   50+            contact gator@halcyon.com for pricing

Both The Psychedelic Screen Saver and CD Spectrum Pro:



   Licenses       Cost per License
   1              $30
   2 - 9          $25
   10 - 49        $15
   50+            contact pixel@halcyon.com for pricing

PAYMENT OPTIONS

You may register via any of the following methods:

PHONE (Credit card only) - provide the information from the order form below to the operator at:

              1-800-699-6395 (10:00 AM - 10:00 PM EST    US Only)
              1-803-699-6395 (10:00 AM - 10:00 PM EST)

FAX (Credit card only) - Fax the order form below to: 

              1-803-699-5465
              (24 hr./day International and business orders encouraged)

EMAIL (Credit card only) - EMail the order form below to:

              CIS: 71561,2751 
              Internet: 71561.2751@compuserve.com 
              (International and business orders encouraged) 

WWW - Fill out the online registration form at:

                http://ourworld.compuserve.com/homepages/starmail/orderfrm.htm

US MAIL - send the order form below to:

              NorthStar Solutions 
              P.O. Box 25262
              Columbia, SC 29224

<- - - - - - - - - - - ORDER FORM / CUT HERE - - - - - - - - - - - ->

Order Form
The Psychedelic Screen Saver v3.5

and/or
CD/Spectrum Pro v3.0

          Name:
      Address1:
      Address2:
          City:         State:            Zip:
       Country:
         Phone:
 Email Address: 

Select products to register:
  Psychedelic Screen Saver with CD/Spectrum Pro (PID 797) $30 / _____



                  Psychedelic Screen Saver v3.x (PID 798) $20 / _____
                                CD/Spectrum Pro (PID 522) $20 / _____ 
          Psychedelic Screen Saver v3.x Upgrade (PID 800) $10 / _____

Check payment type:  Visa ___  MasterCard ___ Discover ___  Check/MO ___

For credit card orders:
   Name as it appears on card: 
                  Card Number: 
              Expiration date: 

Notes:
1)    Be sure to make check/money orders payable to "NorthStar Solutions"
2)    When upgrading please include the full name under which you placed your original order.
3)    NorthStar does not provide technical support, they only handle    registrations.    If you need support, 
please read the section in the    online help that discusses support options.



The Psychedelic Screen Saver
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· QUESTIONS/SUPPORT -- Where can I get help with problems?
· UPDATES -- When is the next version due?



OVERVIEW

    The Psychedelic Screen Saver generates an endless variety of mesmerizing    patterns. As the 
patterns materialize on your screen, the colors will shift,    undulate, and generally speaking, look 
cool. Whether you're into abstract    art, mathematics, or just have a history of mental illness, 
you'll love this screen saver. 
  
    Version 3.5 of The Psychedelic Screen Saver has been designed to work in conjunction with 
CD/Spectrum Pro in order to provide stunning visual effects that synchronize with the sounds 
from an audio device (like the CD player in your computer). With many of the module controls 
you can now associate a sound frequency, a range of effect, and a sensitivity.    Fluctuations in 
the amplitude of the frequency will oscillate the control 
values within the range of effect. 



PSYCH V3.5 RELEASE NOTES

· The Psychedelic Screen Saver v3.5 is available to users who have registered a    previous version of 
The Psychedelic Screen Saver as a $10 upgrade. This fee licenses you for Psych 3.x but not for CD 
Spectrum Pro. CD Spectrum Pro is a separate product made by another ShareWare developer.

· Registering Psych v3.5 gives you a license to use all updates of The Psychedelic Screen Saver prior 
to version 4.0 and *ALL* previous versions.

· You must have a sound card installed (and properly configured) in your system in order for Psych 3.5 
to sync with sound.

· CD Spectrum Pro must be running in order for Psych v3.5 to sync with sound.

· Questions about the screen saver should be sent to pixel@halcyon.com and questions about the CD 
player should be sent to gator@halcyon.com.



BACKGROUND

    The algorithms I used in these screen savers were originally conceived as part of an art project I 
worked on in my senior year at the Evergreen State College.      I implemented the algorithms in about 
70,000 lines of Borlands' Turbo Pascal for MS-DOS and included a "User Interface From Hell" that 
provided access to the hundreds of parameters used to customize the image generation process.    After I 
graduated, I attempted to make a living as an artist by selling the images I produced to various galleries 
around the country.      I quickly discovered that being an artist requires not only a healthy dose of 
creativity, but also a boatload of marketing savvy (which I was lacking).    Since I was having a hard time 
making ends meet, I decided I'd have to find another way to make a living (besides, another month of 
macaroni and cheese would probably have killed me).    After kicking around the idea of putting together a 
company to do the video/effects for raves, I decided that I'd be better off getting a programming position 
with a company that wouldn't require me to wear a suit.    In order to prove I'd done some programming, I 
ported some of my Pascal code for MS-DOS into C for MS Windows and sent it out with my resume.      
The result was the beginning of The Psychedelic Screen Saver.
  
Mike Irvine
Author of The Psychedelic Screen Saver



SYSTEM REQUIREMENTS

Suggested:
· The Psychedelic Screen Saver v3.5 runs quite nicely on a 80486 DX2-66 system.    However, if it is 

being used in conjunction with CD Spectrum Pro then you'll probably want at least Pentium 90 (or 
better <g>)

· Microsoft Windows NT or Windows 95

· 256 color display card - While the screen savers should still work in high/true color modes, you won't 
get palette animation. 

In order to get some of the effects that they use, the screen savers use    a palletized video mode. 
This means that colors are referenced by index    rather than by RGB value. By using a palletized    
video mode, the screen savers can change the RGB value that corresponds to a particular palette 
index and the result is that all of the colors on the screen that use that index are immediately updated. 
Neither high or true color modes use a palette, so it is not possible to achieve the effects without 
manually updating the entire display. Since updating the entire display is far    too slow, I didn't code 
the screen savers to do it. 
 On the bright side, Windows 95 supports dynamic video mode switching which means that the 
display mode can be changed without rebooting the system.    Unfortunately, you are forced to reboot 
your system when you change color depths .    This will be changing in the near future and once it 
does, I'll setup the screen saver to let you pick the video mode that it runs in.    That way you can 
change to a palette based video mode when it starts up and then change back when it's done.    
However, until then, we're stuck with the limitation :-(



INSTALLATION / REMOVAL

To install the Psychedelic Screen Saver, run the setup program (INSTALL.EXE) and then follow the 
directions.    If you later decide that you would like to remove the software from your system, run the 
uninstall program (UNINSTALL.EXE) that's in the directory you installed to.    You can also uninstall from 
the “Add-Remove Programs” applet in the Windows “Control Panel.”



QUESTIONS/SUPPORT

If you have access to the World Wide Web, check out the home page for the Psychedelic Screen Saver 
at:

http://www.halcyon.com/pixel/psych.htm

I maintain a "Frequently Asked Questions" page similar to the FAQ that I've included here with the screen 
saver (but more up to date).    The FAQ provides answers to the vast majority of the questions I get via 
email. 

If you can't find the information you need in the FAQ or in the FAQ on the web, send me (Mike Irvine) 
email at pixel@halcyon.com

If you are experiencing a problem, check to see if the problem exists in the latest version of the software 
which can be found on my WWW site.    If you are still experiencing the problem, email me with a 
description of the behavior and information on your hardware configuration and operating system.    
Please be sure to indicate which version of the the screen saver and which version of the operating 
system you are running.



UPDATES

I post updates to the software on my web site fairly often.    When I'm feeling particularly creative I may 
post updates as many as 2 or 3 times a week :-) 



FAQ
The Psychedelic Screen Saver - Version 3.5
Copyright (C) 1995-1997
All Rights Reserved
http://www.halcyon.com/pixel/psych.htm

Here are a number of the questions that I get asked frequently by folks using The Psychedelic Screen 
Saver. 

QUESTIONS:

1) How come the colors don't "shift and undulate "in high/true color display modes?
2) How can I capture the images that the screen savers generate so that I can    use them for my 
wallpaper, WWW pages, etc...?
3) Do you do custom screen saver development?
4) I've noticed that the date on the ZIP you post changes fairly often but the name hasn't changed (it's still 
psych26.ZIP). 
5) Can I add a link to your page from mine?
6) Once I download the file, how do I set up the screen savers?
7) Where can I find out more about how to write screen savers?
8) What the heck are *.PSY files?
9) What does the "Effects" module do?
10) How come you don’t have documentation for the various controls?
11) Why did you drop support for Windows 3.1?
12) Can Psych 2.5 or later be run on 16 bit Windows?
13) What are the differences between V2.0 and V 2.1?
14) What do you do with the registration information (address, phone number, email ID, etc...)?
15) Will there ever be a Macintosh version?
16) How come when I run the setup program I get a black screen for a second and nothing gets installed?
17) I've noticed that each of the modules has a "Strength" setting -- what the heck does it do?
18) How do I remove SS Runner (Runner.EXE) from my taskbar?
19) How do I remove The Psychedelic Screen Saver from my system?
20) What is your official upgrade policy?
21) I’m seeing these strange boxes that stay around after the screen saver has exited -- do you know 
what’s going on? 
22) My system locks up periodically after running the screen saver – what’s going on?

ANSWERS:

1) How come the colors don't "shift and undulate" in high/true color display modes? 

While the screen savers should still work in high/true color modes, you will only get the palette animation 
effects in 256 color video modes.

In order to get some of the effects that they use, the screen savers use    a palletized    video mode. This 
means that colors are referenced by index    rather than by RGB value. By using a palletized    video 
mode, the screen savers can change the RGB value that corresponds to a particular palette index and 
the result is that all of the colors on the screen that use that index are immediately updated. Neither high 
or true color modes use a palette, so it is not possible to achieve the effects without manually updating 
the entire display. Since updating the entire display is far    too slow, I didn't code the screen savers to do 
it. 

On the bright side, Windows 95 supports dynamic video mode switching which means that the display 
mode can be changed without rebooting the system.    Unfortunately, you are forced to reboot your system 
when you change color depths .    This will be changing in the near future and once it does, I'll setup the 



screen saver to let you pick the video mode that it runs in.    That way you can change to a palette based 
video mode when it starts up and then change back when it's done.    However, until then, we're stuck with 
the limitation :-(

2) How can I capture the images that the screen savers generate so that I can    use them for my 
wallpaper, WWW pages, etc… 

Well, on Windows 3.1 and Windows 95 you can just press the "Print Screen" key and this will copy the 
image to the clipboard. From here, you can paste the image into your favorite image processing 
application and save/edit it. 

On Windows NT, after the screen saver time-out period, the OS switches over to a secure desktop and 
then runs the screen saver. Because of this, pressing the "Print Screen" key will terminate the screen 
saver rather than copying the image to the clipboard. In order to avoid this behavior, you can run the 
screen savers (*.SCR files are just *.EXE files that have been renamed) from the command line or create 
icons for them. When you run them this way, you run them on the application desktop and the "Print 
Screen" key works just fine. 

3) Do you do custom screen saver development? 

No. 

4) I've noticed that the date on the ZIP you post changes fairly often but the name hasn't changed (it's still 
psych26.ZIP).

I make changes fairly often to the screen savers and post the updates in the same file. The reason I 
haven't changed the name is that quite a few people 
have added links to their page that directly reference the file as psych26.ZIP.
In order to make it easier for people to know when I've made updates, I'm going
to put up a page that describes what modifications have been made over what 
time period. I suspect that this will be a bit more convenient than checking 
the file date ;-)

5) Can I add a link to your page from mine? 

Absolutely! However, please reference the page: 

      http://www.halcyon.com/pixel/psych.htm 

rather than the ZIP file. (see #3) 

6) Once I download the file, how do I set up the screen savers?

The file that you've downloaded is actually an archive file that contains the collection of screen savers. In 



order to extract the individual files, you will need to obtain a program that can extraction files from a ZIP 
archive. You can probably find a number of these archive programs from the SimTel Archive.

One commonly used archive program is PKZ204G.EXE.

In any case, once you have used the archive utility to extract the files from the archive file, follow the 
instructions in the README.TXT file on how to setup the screen savers.

7) Where can I find out more about how to write screen savers?

If you are interested in writing screen savers for Windows 3.1, there is a source code sample in the 
Microsoft Windows 3.1 SDK called BOUNCER that should be helpful. If you are interested in writing a 32 
bit screen saver for Windows NT or Windows 95, you might want to check out a sample in the Microsoft 
Win32 SDK called FRACTAL.

To write After Dark modules, you'll want to get a copy of Berkeley Systems'    After Dark Module SDK 
which should be available somewhere on their WWW site at: http://www.berksys.com/

8) What the heck are *.PSY files?

The PSY files are saved setting files. You can use the "Import" button in the "Main Settings" panel to load 
the files and display them. You should also be able to click on the PSY files and have the screen saver 
launch and display using the settings in that file. On my WWW site, there are additional PSY files that 
contain interesting settings. If you are running Microsoft Internet Explorer then you should be able to click 
on the link on my web page in order to launch Psych25 with the settings in that particular file. If you want 
to export your own settings into PSY files, you can just use the "Export" button in the "Main Settings" 
panel. You can also make shortcuts on your desktop to the PSY files so that you can launch the screen 
saver with different settings just by clicking on the shortcut. The PSY files that come with Psych25 get 
installed when you run the setup program. They should show up in the drop-down listbox that contains the 
"Saved Settings" in the "Main Settings" panel. 

9) What does the "Effects" module do?

The "Effects" module differs from the other modules in the way it works. Instead of producing a pattern, 
"Effects" modifies whatever pattern is currently on the screen. So, if nothing is on the screen not much will 
happen :-)

10) How come you don’t have documentation for the various controls?

As you've noticed, I have not provided documentation for all of the various controls and the only way to 
find out what they do is through experimentation. Part of this is due to the fact that many of the controls 
are difficult to describe without resorting to a mathematical description of their function. Another reason 
that there aren't any docs is that I hate writing them :-) I agree that docs would be helpful though so I'll 
see what I can put together for version 3.5. Until then, I've tried to make the experimentation process as 
simple and painless as possible.



11) Why did you drop support for Windows 3.1?

Actually, I got flooded with email from people who were not very happy about me dropping support for the 
Windows 3.1 versions of the software. In light of this, I've decided to continue supporting the 16 bit 
version :-) I should be placing version 2.2 of 16 bit Psych on my WWW site sometime in the near future. It 
will have better palette animation and more palette effects than the present 16 bit version of the collection.

12) Can Psych 2.5 or later be run on 16 bit Windows?

No. There was an error in the documentation (README.TXT) that claimed that Psych 2.5 would run 
under Windows 3.1. Psych 2.5 will *only* run under Windows 95 or Windows NT. It is multi-threaded so it 
won't run under Win32s.

13) What are the differences between V2.0 and V 2.1?

Version 2.1 is pretty much the same as version 2.0. The only major difference is that it comes with a setup 
program :-) 

14) What do you do with the registration information (address, phone number, email ID, etc...)?

I use them to track who is registered so that when people forget their registration numbers I can tell them. 
I DO NOT give them to ANYONE so you will not wind up on mailing lists, telemarketing lists, or any other 
annoying things like these. 

15) Will there ever be a Macintosh version?

No. I had planned to do a Macintosh version of Psych but because of the amount of time and energy 
required to maintain two separate forks of the source code I have decided not to make a Macintosh 
version. Instead, I will apply my energy towards adding new modules and effects to the Win95/WinNT 
versions. My apologies to all of the Macintosh users out there. You can find something for the Mac that is 
similar to The Psychedelic Screen Saver Collection at:

http://www.imaja.com/imaja/BlissSaver.html

16) How come when I run the setup program I get a black screen for a second and nothing gets installed? 

You are trying to install the 32 bit version (Psych 2.5) on Windows 3.1. Psych 2.5 is for Windows 95 and 
Windows NT only. Fortunately there are 16 bit versions that should work just fine on your system. You can 
download them from:

http://www.halcyon.com/pixel/download.htm



17) I've noticed that each of the modules has a "Strength" setting -- what the heck does it do? 

The "Strength" setting is a weighting that controls how much one module is favored compared to another. 
For example, if you made "Pattern" as strong as possible and "Stain" as weak as possible then the 
"Pattern" module would draw quickly while the "Stain" module would lag behind. Strength only has an 
effect when there is more than one module selected.

18) How do I remove SS Runner (Runner.EXE) from my taskbar? 

To remove SS Runner from your task bar you need to follow the following steps:

1. Right click the SS Runner icon on the taskbar and select close from the popup menu.
2. Right click on the taskbar itself and select "Properties" from the popup menu.
3. Select the "Start Menu Programs" tab in the "Taskbar Properties" dialog.
4. Press the "Remove" button.
5. Double click on the "Startup" folder in the tree view in order to see its contents.
6. Select "Runner.EXE" (or "Runner") and press the "Remove" button.
7. Confirm the removal by pressing the "Yes" button.

At this point, SS Runner has been removed from your taskbar and will no longer be run when your 
system is started.

19) How do I remove The Psychedelic Screen Saver from my system? 

If you have version 2.6b or later installed you can run the uninstall program (UnInstall.EXE) that's in the 
directory that you chose to install the screen saver into (C:\Psych by default). 

20) What is your official upgrade policy? 

My policy on upgrades is that, by registering a particular version, you are entitled to use any and all 
versions up to but not including the next major version. 

For example, if you register version 2.1 you are automatically registered for all 1.x and 2.x versions but 
not for 3.x versions. Basically, you get updates to the version you registered and a discount to upgrade to 
a new version.

21) I’m seeing these strange boxes that stay around after the screen saver has exited -- do you know 
what’s going on? 

This problem is probably due either to a problem in your video driver or to the way the driver is 
configured.    There are several things you can try that may resolve the problem.

· Your graphics performance setting may be set to too high a value.    To change the setting, right click 
on "My Computer" and select "Properties" from the popup menu.    Now, select the “Performance" tab 
and then press the "Graphics" button.    This should bring up a slider that will let you control how much 
the acceleration options for your video driver. Try setting the slider all the way to the "None" side and 
see if you still get the problem.    If you don't, try setting it to the next higher value.    Keep doing this 
until you find the fastest setting that doesn’t exhibit the problem.



· Your video driver may have a bug in it.    To see if this is the case, try using a another driver and/or a 
different resolution and see if the problem persists.    (The standard VGA driver that ships with the OS 
is a good one to test with.) If the problem does not occur with a different driver you may want to check 
with the folks who made the video card to see if they have a new version that fixes the problem.    You 
can probably find their WWW site on the internet. 

· If the previous suggestions don’t fix the problem, run the diagnostic program at: 
http://www.halcyon.com/gator/cdsdiag.exe and send me the output and a detailed description of the 
problem you are experiencing via email (pixel@halcyon.com).    This will give me more information 
about your system and drivers. 

1) My system locks up periodically after running the screen saver – what’s going on?

See the answer to #21 (above) since this is probably due to a video driver problem.



MANUAL

    Main Settings
    Palette
    Custom
    Sound
    Display 
    Module Settings

Keyboard Commands



 Main Settings

This is the place where you can build and manage your displays.      A particular display is comprised of 
one or more modules and a palette.    The modules will provide the structure or shapes used in the display 
while the palette will determine the colors used to display the structures.    To select which modules are 
used, check the box corresponding to the name of the module.      If you wish to modify the way that a 
modules draws you can select the tab for that module and make adjustments to its controls.      Similarly, 
select the palette tab if you wish to change to colors used in the display. 

Here is a brief description of each of the controls in the main settings panel:

Active Modules - Determine which modules are being used in the current display.

CPU Usage - Determines how much processing time the screen saver receives when other 
applications are contending for the CPU.    Keep in mind that, the fact that other applications are running 
does not imply that they are placing a high demand on the CPU.    In general, it is a good idea to keep this 
set to the “Low” setting unless the screen saver appears to be running excessively slow.

Animate - Controls how fast the animations are drawn.    This allows users of faster systems to slow 
things down so that they can watch them.

Saved Settings - From here you can pick which settings you are using, save new settings, and export 
settings to *.PSY files.    To pick a new display from the list of available displays, select its name from 
those in the drop-down listbox.    All of the settings for that display will be loaded.    To Save a display, just 
enter a name in the drop-down listbox and press the “Save Selection” button.    You should now see the 
new display listed with the manes of the existing displays.    Likewise, to Delete a display, select it’s name 
from the drop-down listbox and press the “Delete Selection” button.    Its name will be removed from the 
list of available displays.
        In some cases you may want to create a file that contains the settings for a particular display.    This 
can be useful if you want to send the settings to someone else or if you want to create a backup copy of 
the settings.    You can use the Import and Export buttons to load or create saved setting files (*.PSY 
files).    You can also place PSY files on your desktop and launch them by double-clicking on them.      
There is an archive of interesting PSY files available at http://www.halcyon.com/pixel/settings.htm. 

Note:    If you want to capture the current settings while the screen saver is running, press the F1 key.    
This will copy the settings into the list of saved settings under the name “Capture #n”.    Press the F2 key if 
you wish to reinitialize the current settings while the screen saver is running.

Clear Screen - If this is checked, your screen will be cleared when the screen saver starts.    If you are 
using the “Effects” module by itself, you may want to leave this unchecked. 

Seconds to display title - This allows you to configure how long the name of the currently running 
settings will be displayed in the top center of the screen before being erased.    A setting of zero will keep 
the name from being displayed at all. 



 Palette
You can use the Palette configuration panel to control the how the colors are generated for the displays 
you create.    In order to understand how the effects apply, you need to know a little bit about how colors 
are created on the computer.    Each pixel (picture element) on your screen is composed of certain 
amounts of red, green, and blue.    On the computer, these amounts can vary between 0 and 256.    By 
mixing the amounts of red, green, and blue in a particular pixel, you can produce just about any color in 
the spectrum.    The purpose of the palette configuration panel is to allow you to control how the red, 
green and blue will be mixed.

Each of the three color guns (red, green, and blue) can be configured independently of the other two.    
This means that you can apply different effects to each of the guns to produce a wide variety of colors 
when the effects are combined.    In order to control which gun you are editing the settings for, you use the 
three push buttons in the upper left.    They are labeled “Red”, “Green”, and “Blue”:

Red - If this button is depressed then all setting changes are applied to the red color gun.

Green - If this button is depressed then all setting changes are applied to the green color gun.

Blue - If this button is depressed then all setting changes are applied to the blue color gun.

Color Effects - These control how the palette engine generates colors for the color gun you’ve selected.

Ramp - Generate intensities that start out bright then fade to black. You can control how quickly the fade 
to black takes place by using the “Ramp Frequency” control.

Fade - Generate intensities that will start out black then brighten and then fade to black again. You can 
control how quickly the fade takes place by using the “Fade Frequency” control.

Smooth - Will generate smooth, even, intensity transitions.

Coarse - Will generate intensity transitions that vary.

Blackout - Will set the intensity to 0.

Random - Will randomly pick one of the previous color effect options.

Custom - Intensities will be taken from the custom palette created in the “Custom” configuration panel.

Control Settings - Use these to configure how the color effects are applied.

Brightness - This will scale all of the intensities for the selected color gun.    A value of 50 would 
indicate that all values will be reduced by 50%.

Color Frequency - This control how quickly the selected gun will oscillate.    A high value will produce 
faster, more hectic, intensity transitions while lower values will produce smoother, more gradual, intensity 
transitions.



Fade Frequency - If the “Fade” color effect is selected, this will control how fast the fade takes place.
 
Ramp Frequency - If the “Ramp” color effect is selected, this will control how fast the fade takes 
place.

Duration - This controls how long (in seconds) the set of settings for the selected gun will last before a 
new set is generated.    When a new set of settings is generated, the old settings are morphed (or 
interpolated) into the new settings (this produces smoother transitions between settings).    You can 
control how quickly the interpolation occurs using the “Morph Rate” control documented below.

Cycle Rate - This controls how much delay (in milliseconds) there is between palette animation 
frames.    Lower values will cause the palette to animate faster.    At the present, only the “Red” gun is 
used -- its value is applied to green and blue. 

Event Rate - This controls how often an event will take place for the selected gun.    Events include 
things like changing the direction of animation or changing the frequency of the intensity transitions.

Direction - This controls which “direction” the selected color gun will animate and how fast it will move 
in that direction.

Morph Rate - This controls how quickly the transition from one set of settings to another will take place 
for the selected gun.    A lower value will produce more gradual transitions while a high value will produce 
faster transitions.

Intensity - Like the brightness control, this will scale all of the intensities for the selected color gun.    
The difference is that the “Intensity” value is only applied to the intensities generated in the current frame 
of the animation rather than all the intensities (as brightness is).



 Sound

Use the controls here to configure general options relating to the interaction between CD Spectrum Pro 
and The Psychedelic Screen Saver.    To configure a particular palette or module control to use sound, 
select the "Palette" or module panel and set the "Source" for the control to one of the sound options.    
Please note that not all controls support sound based sources.    If you are looking for tips and tricks on 
how to use the screen saver with sound, be sure to read the topic titled "Using The Psychedelic Screen 
Saver With CD/Spectrum Pro."

Allow Palette Sync - If CD Spectrum Pro is running and this is checked, palette settings that use 
sound sources will use data from CDSPro to provide sound sync.    If this is not checked, palette settings 
that use sound will be forced to an “Oscillate” source at run time.    This control can be used to see how a 
particular setting configuration will look on systems that don’t have CDSPro installed.

Allow Drawing Sync - If CD Spectrum Pro is running and this is checked, module settings that use 
sound sources will use data from CDSPro to provide sound sync.    If this is not checked, module settings 
that use sound will be forced to an “Oscillate” source at run time.    This control can be used to see how a 
particular setting configuration will look on systems that don’t have CDSPro installed.

Turbo Mode - If CD Spectrum Pro is running and this is checked, the all sound sources that specify a 
frequency source will be forced to a “Volume” source at run time.    This keeps CDSPro from having to 
apply a time consuming FFT to the data before passing it on to the screen saver. 

Display CD Info - If CD Spectrum Pro is running and this is checked, the title, track, and artist 
information for the current audio CD will be displayed in the lower left corner of the screen for a few 
seconds every time a new track begins. 

Auto run CDS/Pro - If this is checked, then CD Spectrum Pro will be run whenever the screen saver 
is run.    We recommend that you leave this turned off to avoid scenarios where you leave your office for a 
few minutes and the screen saver kicks in and launches the Megadeath CD you just purchased at peak 
volume.      This particular option is not conducive to good relations with your coworkers. 

Auto Adjust Gain - If this is checked, the screen saver will attempt to adjust the gain level that is 
applied to the data from CD Spectrum Pro to provide reasonable visual appearance.    If this is not 
checked, you will need to adjust the gain slider in CDSPro manually.



 Display
Current Display Mode - This provides you with information about the video mode that your system 
is presently configured to use.      It will tell you the x and y resolutions of the display and the number of 
colors that can be displayed at once on the screen. 

Run screen saver in - This provides you with information about the video mode that the screen 
saver will use. 

Available Modes - This is a list of the video modes that are supported by your video card and driver. 
Please keep in mind that some video modes may be supported by your card that are not supported by 
your monitor.    As a result, changing the display mode can leave your display unreadable if your monitor 
does not support the settings you select.      Avoid changing to a display mode that you can't test first 
unless you already know that your monitor will support it.

Set - This button will set the video mode that the screen saver will use to the currently selected entry in 
the “Available Modes” list.      If the video mode that you select requires a reboot then you will not be 
allowed to choose that mode.

Clear - This button will set the video mode that the screen saver will use to the default video mode that 
appears in the “Current Display Mode”    box.

Test - This button will allow you to test the currently selected entry in the “Available Modes” list. If the 
video mode that you select requires a reboot then you will not be allowed to test that mode.

Use - This button will set the video mode that your system uses to the currently selected entry in the 
“Available Modes” list.      If the video mode that you select requires a reboot then you will not be allowed 
to choose that mode.

Notes: 

· Windows 95 does not support mode switching between modes with different color depths without 
rebooting the system.    Windows NT 4.0 does provide this capability.

· The Psychedelic Screen Saver looks best in 256 color video modes since these modes usually 
support palette animation.    Please see the FAQ for more information on video modes.



 Module Settings
At this point, the individual controls for each of modules are not documented.      However, here are some 
general pointers on how the controls operate.    In general, controls are composed of several parts.    To 
the right of a control is a drop down list box that you can use to select the source for a particular control.    
The source determines where that control gets information on how to calculate a value.    The control will 
change depending on the source that is selected.    Sources could be any of the following:

Here are a few examples of the way controls can appear. 

A) 

B) 

C) 

D) 

Set - The value for the control is set to whatever value is indicated by the slider component.    The controls 
in    “A” (above) demonstrate a “Set” source.    In this case, the value will be set to 2.

Random - The value for the control is set randomly generate so that it is between the two values 
indicated by the two sliders. The controls in    “B” (above) demonstrate a “Random” source.    In this case, 
the value will be a random number between 0 and 100.

Oscillate - The value for the control will oscillate between the values indicated by the two sliders.    The 
frequency of the oscillation can be controlled using the up/down control just to the left of the source 
control. Higher values for the frequency will yield faster oscillation. The controls in    “C” (above) 
demonstrate a “Oscillate” source.    In this case, the value will oscillate between 1 and 50 with a frequency 
of 10 (fastest).

Volume (and all frequency ranges)  - The value for the control will set between the values indicated by 
the two sliders using the volume from the audio input source.    The sensitivity of the audio sampling can 
be controlled using the up/down control just to the left of the source control.    Higher values for the 
sensitivity will yield faster sampling and be responsive to amplitude changes. The controls in    “D” (above) 
demonstrate a “Volume” source (frequency sources work the same way).    In this case, the value will 
fluctuate between 0 and 320 with a sensitivity of 10 (the most sensitive).



Keyboard Commands
There are a number of keyboard commands that you can use to control the screen saver while it is 
running. 

F1 - Captures the current display and saves it to the list of saved displays.    You can select,    rename, 
review, and/or edit the display in the main settings panel for the screen saver.    The captured display will 
show up under the name “Capture #n” where “n” is the number of the capture.

F2 - Advances the screen saver to the next set of settings for the current display.    If you are running in a 
random mode where you are selecting from the saved displays, then you will get a new display.    If you 
are running in a random mode where you are selecting from a set of modules, a new subset will be 
selected. 

F3 - Captures the current display and saves it to the list of saved displays.    This option is exactly like F1 
except that it will capture the current color palette (instead of the current palette control parameters) and 
set the animation type to “Custom.”    This way, you can get a moving snapshot of the current display.

F4 - Advances the palette to the next palette by generating new parameters for the palette controls. 

F5 - Toggle suspend/resume drawing and palette animation.

F6 - Toggle suspend/resume drawing.

F7 - Toggle suspend/resume palette animation.

F8 - Reverse palette animation direction for all color guns.

F9 - Toggle disable/enable mouse interrupt.    You can use this to stop (or start) mouse movements from 
waking up the screen saver.    Keep in mind that you can still wake up the screen saver by pressing a 
keyboard key that is not part of this command list.



 Custom Palette Settings

The custom palette editor allows you to specify the colors that will be used when the “Color Effect”    in the 
“Palette” configuration panel is set to “Custom”.      Use the mouse to select    an index or a range of 
indices from the palette and then use the functions listed below to adjust them.

R / G / B - Controls how much red/green/blue is in the selected range.

Random - Generates a random gradient of colors for the currently selected indices.

Negative - Sets each of the currently selected indices to their color negative.

Reverse - Reverses the range of currently selected indices.

CopyTo - Copy from one index or range of indices to another.    Select an index or range as a source 
then press CopyTo and select a new index or range as a destination.

Gradient - Takes the first and last color in the selected range and generates all of the colors between 
them in RGB color space.

Undo - Undoes the previous operation.    The undo buffer is only one entry so pressing undo twice is the 
same as not pressing it at all.

Smooth - Takes all of the colors in the selected range and modifies the RGB values so that they are 
more like the neighboring colors.

Rough - Randomly modifies the RGB values of the colors in the selected range by a small amount.

Shift - Swaps the red, green and blue values for the selected range.    Red gets the value of green, 
green gets the value of    blue, and blue gets the value of red.

Import - Allows you to load a palette from a file.

Export - Allows you to save the current palette to a file.

Red, Green, and Blue Masks - Prevent color operations from effecting a particular gun.



Using The Psychedelic Screen Saver With 
CD/Spectrum Pro

Here are a few hints, tips, tricks, and techniques to get the most out of using the two programs together.

· Settings shipped with the screen saver are prefaced by "[S] " if they use sound -- be sure to try one of 
these.    "[S] Twitch" is a pretty good one for demonstrating    the sound synchronization. 

· Music with a strong on-beat followed by a soft off-beat will produce the most dramatic results.

· If you aren’t seeing the patterns synchronizing with sound, check to see if sound synchronization is 
possible with your current system configuration.    When you run CD Spectrum Pro and engage the 
spectrum, do the bars move with the sounds from the CD player?      If not, you’ll need to get this to 
work before the screen saver will synchronize with sound.    Please see the CD Spectrum Pro FAQ for 
information on how to troubleshoot this problem.

· If the screen saver runs very slow with the sound engaged, try changing the "CPU Usage" (in the 
screen savers “Main Settings” panel) to "Normal" rather than "Low" -- this should help speed up the 
drawing.

· CD Spectrum Pro must be running for sound synchronization to work.      If it isn't, and you run one of 
the settings that use sound, all    of the control values that use sound are changed to "Oscillate"    at 
run-time. 

· If the synchronization doesn't appear to have much variation within the    selected range, try checking 
the "Auto Gain" option in the    "Sound" settings panel.

· If you have a fast machine, leave everything on and enjoy the ride. But if your machine is having 
trouble keeping up, the following CD Spectrum Pro options can be modified to increase performance:

· Turn off the volume taskbar icon. 

· Make the spectrum window smaller, or turn it off. 

· FFT less than all of the data (right-click on the "wavin" indicator).





CD / Spectrum Pro FAQ
(Frequently Asked Questions)

By far, the most common issues revolve around sound card and driver problems. Please, before sending 
email with a problem report, be sure your system is in a state where you can record CD audio using only 
the Win95/NT CD player and the Win95/NT Sound Recorder. CD/Spectrum Pro requires that your system 
be able to do this. All multimedia systems should be able to do this with no trouble. However, some 
drivers exist that can't handle this task properly. If you are unfortunate enough to have one of those 
drivers, you should contact your computer or sound card manufacturer for a replacement driver.

CD/Spectrum Pro uses the same resources and functionality as the combination of the Win95/NT CD 
player and the Win95/NT Sound Recorder. Once your system is in a state where those two applications 
can be used to record CD audio, chances are *very* good that CD/Spectrum Pro will work flawlessly. 

Frequently Asked Questions:

Why isn't the spectrum animating?
Why is the system so slow when CD/Spectrum Pro is running?
Why can't I hear the music when CD/Spectrum Pro is running?

Why do I get some color squares even when the CD is stopped?
How can I check for hardware conflicts?

Is CD/Spectrum Pro an equalizer?
How would I write a similar program?



CD/Spectrum Pro FAQ: Why isn't the spectrum animating?

There are five common causes for this. 

· The gain is set too low - drag it up.
· The CD audio line volume is set too low - look in the Mixer window and drag it up.. 
· The color of the spectrum is set to the same as the color of the background - right-click on the 

spectrum graphics and choose Configure. From there, you can set colors.
· The CD player is not hooked up to the sound card - if you are able to listen to CDs only through 

headphones, this is your scenario. (By the same token, if you listen to CDs through your sound card, 
this is not your scenario.) You need to connect a proper cable between your CD player and your 
sound card. Please let only a qualified technician perform this. 

· By far, the most common cause of this problem is that the sound card is configured to digitize an 
audio source other than the CD audio (usually the microphone). Look in the Mixer window in 
CD/Spectrum Pro. If the Mixer window will not come up, then you will need to use whatever software 
came with your sound card because your sound card does not support standard mixer interfaces for 
programmers to access the card.

CD/Spectrum Pro uses the same mechanisms in your computer that are used by the Windows 95/NT 
components 'CDPlayer' and 'Sound Recorder'. You should first make sure that you can indeed record CD 
Audio by shutting down CD/Spectrum Pro and playing a CD with the Win95/NT CD player and recording 
with the Win95/NT Sound Recorder. Once you can successfully do this, chances are good that 
CD/Spectrum Pro will work fine.



CD/Spectrum Pro FAQ: Why is the system so slow when CD/Spectrum Pro is running?

Some CDROM drivers (usually real-mode drivers) can cause CD/Spectrum Pro to have very poor 
performance. On systems equipped with those faulty drivers, other applications become extremely 
sluggish whenever CD/Spectrum Pro is running. Admittedly, CD/Spectrum Pro is a demanding 
application. But when running on good drivers, reasonable performance should be expected even on high 
end 486 machines, or low end Pentiums. 
If your machine has one of these slow drivers, the best thing you can do (short of buying a new CD drive, 
or getting better drivers) is to disable the CD player in CD/Spectrum Pro and use only the spectrum 
analyzer. This will allow you to continue to use The Psychedelic Screen Saver to produce visuals that 
sync to the beat.
To disable the CD part of CD/Spectrum Pro, right-click on the “CD” indicator in the Console window. 
Choose “Disable CD Engine”.
You should also visit the web site of the computer, or CD driver manufacturer. They may have a newer 
fixed driver available. They may also have a feedback mechanism where you can let them know you are 
unhappy with the quality of their drivers.



CD/Spectrum Pro FAQ: Why can't I hear the music when CD/Spectrum Pro is running?

Some "off-brand" sound cards do not permit simultaneous listening and recording of sound. When 
recording starts, they stop sending the sound to the speakers. CD/Spectrum Pro uses the wave capture, 
or recording mechanism to determine what the sound looks like. Therefore, on these substandard cards, 
the sound will go silent when the spectrum is engaged. Although there is nothing I can do about this, 
there is something you can do - complain to your sound card manufacturer and ask for updated drivers. It 
is possible that they have a driver that will fix the problem. Also, keep this in mind the next time you buy a 
sound card - is it *really* SoundBlaster compatible? SoundBlasters are :) 



CD/Spectrum Pro FAQ: Why do I get some color squares even when the CD is stopped?

The color you see (usually in the left-most bin) is simply the baseline noise that your sound card is putting 
out. I don't make the sound, I just FFT it :)      Sometimes, the sound is due to the digitizing of the ambient 
noise in the room captured by the microphone. If you have a microphone attached, look in the Mixer 
window, under “Record”, and you can turn off the microphone input.



CD/Spectrum Pro FAQ: How can I check for hardware conflicts?

Look in
Start->Settings->Control Panel->System->DeviceManager

and make sure your CD player and sound card are configured properly with no resource conflicts. 



CD/Spectrum Pro FAQ: Is CD/Spectrum Pro an equalizer?

No, CD/Spectrum Pro is not an equalizer. It is a spectrum analyzer. This means that it simply displays the 
frequency spectra without giving you any opportunity to adjust them. I may add equalizer capabilities 
when more sound cards support full-duplex wave I/O, but that remains to be seen.



CD/Spectrum Pro FAQ: How would I write a similar program?

I've had many requests for information regarding how to write code to do some of the things that 
CD/Spectrum Pro does. I regret that I don't have the bandwidth to answer programming questions, but I 
will offer the following:
· CD/Spectrum Pro was written in C using the Win32 SDK.
· Most of the interesting code uses the multimedia APIs and some OLE/COM. You can find 

documentation on everything I did with those APIs in the Win32 SDK online help, or on MSDN.
· Specifically, folks seem to be interested in the spectrum analysis. I use standard Win32 multimedia 

APIs to gather the data. You should be able to find all you need in the online help for the Win32 SDK. 
To process the data, I use a Fast Fourier Transform (FFT) - although there are other transformation 
functions available. Unfortunately, the FFT is too complex to describe here, or in email - so your best 
bet would be the local library. Be prepared to invest a hefty amount to time to reach "FFT Nirvana" - 
for me it was several months. 





CDP File Viewer (also known as CDP Tool)

The CDP Tool is a utility program provided with CD/Spectrum Pro to allow access to CDP files. A CDP file 
is a file containing the information (CD title, track names, artist, etc) for one or more CDs. These files can 
then be emailed, or put on web sites, or otherwise exchanged so that others can benefit from your effort 
of typing in all of that information. (Of course you too can benefit by finding CDP files for your CDs.)

The best way to understand how CDP Tool works is to play with it. For that reason, the majority of the 
help below is in the format of tutorials on how to perform common tasks in CDP Tool. The overview is 
short, so read that first, then come back here and click on the task you are trying to perform to learn how 
to do it.

· Overview
· What do all of those menu options actually do?
· How do I make a backup?
· How do I import CDP files?
· How do I create a CDP file?
· How do I copy/move CDP information from one CDP file to another?



CDP Tool Overview

The CDP Tool main window is split into two parts - left and right. On the left is a tree-view showing the 
registry, files and CDs. On the right is shown the contents of whatever is selected on the left.

The tree-view on the left always has at least one entry - “CD Info in Registry”. Additionally, it may contain 
any number of other entries, each being either a file or a CD. CD entries are always under either the 
registry entry, or a file entry. You can click the “+” to the left of the registry or file entry to get it to expand 
and show you the CD entries.

The CDs listed under “CD Info in Registry” are the ones that CD/Spectrum Pro knows about. To get 
CD/Spectrum Pro to recognize a CDP info, you have to get that info into the “CD Info in Registry” entry. 
There are several ways to do this. 

You can also get additional file entries in the left side by opening CDP files, or by selecting File->New to 
create a new file.

If you select (click on) a file entry or the registry entry in the left side, the right side of the CDP Tool will 
show you the CDs which are contained in that entry. If you select a CD entry on the left side, the right side 
of the CDP Tool will show you the track and title information for that CD.



CDP Tool - How do I make a backup?

Making a backup of your CD information is very easy. Simply choose the menu option:
File->Make Backup

The program will then prompt you for a file name. Type in the name of the CDP file in which you’d like to 
store all of your CDs’ informations, and click “Save”.

Once you’ve made a backup, we urge you to send it (via a binary attachment to email) to 
gator@halcyon.com. This way, if your machine ever does crash (it can happen to anyone), you can 
simply connect to the web site and with a couple mouse clicks all of your CD information will be back on 
your computer. Also, this will allow other folks to benefit from your effort of typing in the CD information. If 
we make the CDP file library larger, everyone wins!



CDP Tool - How do I import CDP files?

There are four ways to import a CDP File:

1) Click on the CDP file from inside Internet Explorer (or any browser that adheres to standards 
regarding file associations). This will automatically launch the CDP Tool in import mode. In import 
mode, only a dialog box is shown, and in that dialog you select the CDs which you wish to import, 
then click on the “Import” button.

2) Double-click on the CDP file in Windows’ Explorer, or right-click on the file and choose Open. This too 
will bring up the CDP Tool in Import mode, described in #1 above.

3) Start CDP Tool, then choose menu option File->Import. This will bring up a dialog in which you enter 
the CDP file name (or browse for it) then click on the “Open” button. At this point you will see the 
Import mode dialog described in #1 above.

4) Start CDP Tool, then choose the menu option File->Open to open the CDP file. After entering the file 
name, you will see an additional entry in the left side tree-view of the main application. From there 
you can follow the directions in the section on moving CD information between files to move the CD 
informations into the “CD Info in Registry” entry.

A note about internet browsers: Some versions of Netscape’s browser choose to ignore file associations 
and therefore are unable to launch CDP Tool when you click on a CDP file inside that browser. There is 
nothing I can do about Netscape’s error in this case. Similarly, I’ve had several reports that AOL’s browser 
has trouble with the CD/Spectrum Pro web site. I’m told that newer versions of AOL work fine with it, but 
in any case you can always choose to use Internet Explorer, or a good version of Netscape. I’m also told 
that even with AOL, you can use these other browsers.



CDP Tool - How do I create a CDP file?

There are two ways to create a new CDP file:
1) The easiest way is to create a backup using the directions in this help file.
2) You can also choose the menu option - File->New, then move some CD information into that file using 

the directions in the section on moving CD information between files, then choose File->Save to write 
the new file.

In the section on moving CD information between files, directions are given for an example in which a 
new CDP file is created.



CDP Tool - How do I copy/move CDP information from one CDP file to another?

CDP Tool uses the clipboard to shuffle CDP information between CDP files (between entries in the left-
side tree-view). The following example shows how this works:

Note: to prepare for this example, you’ll need to have at least one CD information already either typed in, 
or imported into the registry.

Directions:
1) Start CDP Tool (in the left side, you should see only “CD Info in Registry”)
2) Choose the menu option File->New (you should now have an “Untitled” entry in the left)
3) Left-click on “CD Info in Registry” (the right side should show the CDs you’ve entered/imported)
4) Select one or more CDs from the list in the right side of the main window by clicking on them.
5) Choose the menu option Edit->Copy
6) Left-click on the “Untitled” entry in the left side. (the right side should go blank)
7) Choose the menu option Edit->Paste (the right side should show the CDs you copied)
8) Choose the menu option File->Save (type in a filename and hit “Save”)



CDP Tool - What do all of those menu options actually do?
· File

· New - creates a new file entry in the left side. You can later copy/move CD information into 
that file and save it.

· Open - opens a CDP file on disk.
· Import - imports the CD information in a CDP file on disk.
· Save - saves a CDP file.
· Save As - saves a CDP file under a new name.
· Close - closes a CDP file entry.
· Close All - closes all CDP file entries (except “CD Info in Registry”)
· Make Backup - makes a backup of all CDP information currently stored in the registry.
· Exit - closes CDP Tool.

· Edit
· Copy - copies the selected CDP information(s) to the clipboard.
· Copy Text - copied the selected CDP information to the clipboard in text format.
· Cut - copies the selected CDP information(s) to the clipboard, deleting it from the current file 

entry.
· Delete - deletes the current CDP information.
· Paste - pastes in CDP information(s) from the clipboard to the current CDP file entry.
· Edit - launches dialog in which you can edit the current CDP information, including title, track 

names, artist(s), etc.
· Select All - selects all CD informations.
· Select None - selects no CD informations.

· View
· Sort by Artist - sorts the list using artist name as key.
· Sort by Title - sorts the list using CD title as key.
· Sort by CDID - sorts the list using CD ID as key.
· Show Artist - toggles display of the artist name.
· Show Title - toggles display of the CD title.
· Show CDID - toggles display of the CD ID.

· WebLinks - If you have a properly configured web browser, these options will take you to various web 
pages:

· CD/Spectrum Pro Home Page - the main CD/Spectrum Pro web page.
· CDP File Library - the place to get free CDP informations.
· FAQ (Frequently Asked Questions) - the FAQ and troubleshooting pages in case you are 

having trouble.
· Online Documentation - this manual on the web.
· License Agreement - the license agreement you agree to by installing and using this product.
· Technical Support - where to get technical support for CD/Spectrum Pro and CDP Tool.

· Help
· Help - Launches help.
· About - an about box.






